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Sequence Overview |ﬂdueCn'!§Me

1.Altium Project preparation
2.Coll Calculations

3.Running the Altium Script
4.Multi-layer Coils and Sensor

connections
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Setting Up an Altium Project
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Project Preparation

Only necessary for a new, empty project.

Create a new PCB project:
File » New P Project » PCB Project

Tl Confidential —

Altium Designer (Platfo

InducT

Sensk:

H DXP :| File View Project Tools Run  Window Help ¢ C\Users\aD412182\Documents\Pre = '+
= | Mew » | L2 Schematic = |‘é’]|___;o E]
7 Open.. Ctrl+0 £  OpenBus System Document ha>-cober vhs
Close Ctrl+F4 B3 pce F
& Open Project. ] WHDL Decument nit) Then
. .Checked = false
Open Design Workspace... il Verilog Document
Check Out... ol C Source Document .Checked = true
5 1l C++ Source Document tric, 1 = Inch
lal  Save Ctrl+5 2 c
[l C/C++ Header Document
Save As.. i i
=l ASM Source Document 36, 233, 216 )
Save Copy As.. = corware Platform D 36, 233, 216)
Save Al 1= Software Platform Document GB (236, 233, 216)
. ] Text Document (236, 233, 216)
Save Project As... . B (236, 233, 216)
=% CAM Document X . ,
Save Design Workspace As... " - 236, 233, 216)
= Output Job File (236, 233, 21g)
C t Release M 236, 233, 216
omponent Release Manager. G Database Link File 2 2 2186)
Page Setup...
age sslup Project v |&al PCB Project
3 Print Preview...
& Fnmreaew Library v | @] EPGA Project
4 Print.. Ctrl+P - .
= H Script Files ¥ |1 CoreProject
& Smart PDF.. Mixed-Signal Simulaticn ¥ | &t Integrated Library
Import Wizard Other ¥ | il Embedded Project
Recent Documents » | i Design Workspace il Script Project P
Recent Projects , [T mperen T oEmgn Compiler © Scnpt | Help | Ins!
Create MHew R
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Schematic Entry of the Sensor |ﬂdueCn'!§>ée

If the sensor capacitor is not present
on the schematic, enter it onto the
appropriate schematic page:

(Tip — select the correct package
size,10pF is typically too low a C)

—C1
10pF

Now enter the coil —this can be *
done by simply shorting the ——C1
capacitor: ® 10pF

Enter a Net Name for the coil ==
E DxP File Edit View Project Place Design Tools  Simulator ﬁem by ~ = ~
NSHZRe@RE @ A+ ot |9 e 2|8 i ”‘ru»_l

i PCB_Coil

Now save the schematic: C1
| 10pF
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On the PCB: |ﬂdUCT

Sensk ng

A new Altium project places instructions on how to change the size of
the PCB. Follow these instructions if necessary, then simply select and
delete the instructions:

E DXP File Edit View Project Place Design Tools Auto Route Reports Window Help (b - — - & o |==~ =3 ~ HE - 000

N mir=mrEr i B 2 } -
NEHSQA|®B QW Q| & 2@ @i+ 2wl 4, | (Mot saved) . $© @ VI sl A S [NoVariat
Projects - W )
[ BlankSheet_ANSIB.SchDoc| | [5]] spiral2-cobervbs | | [ BlankSheet_ANSKB.SchDoc| | BB xcoocc PebDoc *
Workspace'l Diaridth = Ll Win=kall Tabsl 1n =milk=cresred box afber Tinel vaszh,  Tewh =Fall b= & pb Fonb, TexkE zhall be per Teble |
| Z2z B These afsanblies & e ES0 Sercitlve, ESD pr'él:il.ltloni =hall be obserwad,
N ; ZZ= B These assenblies rast be clean and Free drom Hlux and all conamnancs. Use of ra clean flus: Ls nat accedtable

‘ PCE_Project].PiFCE ” Project ] Z24 B These acseablics budt coaply with wirknanship Sfandards 1PC—A—£10 Clagé 2., uhlée ofheeul @6 Speci4ied.

(@ FileView () Stucture Editor

=52l PCB_Project1 PriPCB =
= Source Documents
& Cover Shest_&M5I-B.SchDoc ®
2 BlankSheet_ANSI-B.SchDoc
LE Hardware_AMNSI-B.SchDoc *

oI T, E
4

= |_'I Settmgs
= Free Documents
1L Saurce Documents
57l spiral2-cober vbs
[ BlankSheet_ANS5I-B.SchDoc
@‘ﬂ nanline_rect_zpiral. vbs

3450, 00mL 1

Legend i= r

Orill Table
ThaLE

_ Lab
=1 H i 2
Q e B ] Fra e

ooz Change
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Update the PCB with the schematic:

The sensor cap and the coil need to be added onto the PCB:
Design » Import Changes from <ProjectName>

Be sure to click on Execute Changes!
Then press Close.

& Altium Designer (Platform 27009) - xwoooocPcbDoc * - PCE_Projectl.PrPCB. Licensed to Texas Instruments (SVA). Chns Oberh

}j DXP File Edit View Project Place Qesign|IUD|5 Auto Route  Reports  Window  Help & - = -

l....==............
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RE=R"™ i= QF* P | |2 g Qg Update Schematics in PCB_Projectl.PriPCE (Mot Saved)
Projects ¥ 6 Import Changes From PCB Projectl PGPCB |1 —
Workzpace] Dantwfrl - |Wolkspac Rules... = I
PCE_Project]. PriFCE | Project Rule Wizard... ] i
= = H ]
@ File View Stucture E ditar |ﬁ| 15] Board Shape (3 = I
= gl PCB_Project!.PriPCB = Netlist " BN i
B Source Documents Layer Stack Manager... ] ]
[ Cover Sheet_aMN5I-B.SchDoc * ] i
[ BlankShee!_ANSIB.SchDoc Board Layers & Colors... L N i
.2 Hardware_ &M51-B.5chDoc * Manage Layer Sets 3 . I
B cblloc * . I
L1 Settings Rooms ' ] ]
=l Free Documents Classes... . I
=l Source Documents . I
(51 spiral2-cober vhs ., Browse Components... ] ]
[ BlarkShest_4NSIB.SchDoc . , | i
i B | Add/Remove Library... ] ]

lg] nonline_rect_zpiral vbe

Make PCE Library = =
Make Integrated Library ] i
Board Options... = H
Bl
]
]
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Colil Calculations
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The Excel Inductance calculator '”dugﬁ,!%hée

Determine coil that fits within available geometric constraints:

Only enter into the|Yellow|fields; the-fields are outputs

Nominal Calculation: 2 layers
# of turns n 23|Turns/layer
Inner Diameter |d 0.754 |mm 29.70|mil
spacing S 0.1016]|mm 4.00(mil
width w 0.1016{mm 4.00|mil
Outer Diameter |d s 10.000{mm 393.70|mil
layer spacing X 0.15(mm 5.91|mil
davg 5.3772|mm 211.70]|mil
p 0.8597
L 2.5170 |uH
Kc 0.8863
Liotal 9.4957|uH
Tank Cap C 300.0000|pf
Frequency Fosc 2981.92|kHz
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Running Scripts
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Opening the Script file |ﬂdUCT \VE

Senskng

Goto File » Open

Navigate to the script file location.

But you won’t see the script files until you filter for them!
Choose “Script file (*.bas; *.pas; *.inc;” or All files.

’
& Choose Document to Open

Organize « MNew folder

Pl Desktop o

Projects library

= Recent Places |E| Altium,_Scripts Arrange by:  Folder ~
4. Downloads T ]
Mame ate modified Type Size
i Libraries | Histary 1N/2014 11:53 AM  File folder

3 Documents | nonline_rect_spiral.vbs /98014 11:53 AM  VBScript Script File

J" Music 3| nonline_rect_spiral-cober.vbs /X414 1:29 PM VBScript Script File 1
| Pictures rect_spiral-cobervbs 10/10/013 5:21 PM VBScript Script File 1
il Projects ] spiral2-cober.vbs 10/10/243 2:08 PM  VBScript Script File

J Projects (C:)
. Arcturus

. Audio_Projects
. Coding_Workspace

. General_Project_Info

- | 4 1 3
I File name: + | Script file (*.bas; *.pas; “.ing; .t v]
I

| open || canca |
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Before running the script: |nduecn!a

1. Select the PCB in the Project.
2. Goto the layer where the Coil should be placed:
For example, the Top Layer or Bottom Layer.

}ﬂ DxP File Edit View Project Place Design Tools Aute Route Reports Window Help Lo

=v g v - swocooePcbDoc?ViewMName=PCBEd -
TR T e | | (Not Saved) - | A Novoritions] - 8

X
— [ Blanksheet_ANSHB SchbDoc| | [5]] spiral2-cobervos| | [ BlankSheet_ANSHB.SchDoc| B8 socoooc PebDoc *

A |WD[kSDaEE| 1 1 1 1 1 1 1 1 | 1 1 1 1 1 1 1 1 1 1 1 1 1T 1 1T 1 1 1T T 71T 711 ;

| Project |

® File View (=l 2]

Ba
L Settings
EILd Free Documents
B Source Documents
_‘1] spiral2-cober vbs
2 BlankSheet_AMSI-E.SchDoc
_‘1] nonline_rect_spiral vbs

ottorn Laper | M M1 Boad Outine /| M 12 Board Dimensions | M b3 30 STEP Top { M M4 3D STEP Bottom /| M M5 AssemtER £+7 Snap Mask Level Clear

Files » Projects [ MNavigator /{ PCE [ PCE Filter S \I Top Layer
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Running the Script

Induc

T\ve

Senskng

1. Select the DXP in top Left
Place Design Tools Simulator  Reports  Window  Help b - =~
b % W | it 7 B Fer) L M€ o m
=S

Eile Edit  View Project
A5 L ®H Q&S Q-

2. Select DXP » Run Script

3. In the Select Item To Run
window, choose Main under

,

Select script o run

4 ﬁ EBG_Scriptz.PriScr
. tinCopperTrack\width. paz
- DetermineMiniumCopperTrackifidth

. PADS_PCAD_migration pas
- UpdateSchematicP arameterhlames
a E PlaceRectangle. vbs
- Main

4 ﬁ Free Documents
A--E nonling_rect_spiral. vbe

the opened script file. e
o -\ spiale-cober vbs
<X

4. Left Click OK ONCE!
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Coil Positioning Induecn'!'g%e

Bl Dxp : Ele Edit View Project Place Design JTools AutoRoute Reports Window Help - &7 -

UESH S S | @@ @ Qe ar e N L, | (Not Saved) g | s A i [NoVariations] - g8
Projects v @ x

Th e SC I’I pt h aS ‘workspace]. Dsriwrk.

PCB_Project1.PriPCE

= - - o000 PcbDociViewName=PCBEdT @

_; BlankSheet_ANSIB SchDoc _‘ﬂ spiral2-cobervbs ._; BlankSheet_ANSLB SchDoc| | HE xooooc PebDoc *

p | ac ed A| t| um ® Fis View (O Sttuctus Edior
. =3l PCB_Project1.PriPCB =
into a select S e renr a1 8 SchDoo
. (=] BlankSheet_ANSI-B.SchDoc
m 0 d e — th e r e W I I | ;jHaldwalaﬁANS\rE SchDoc
. 1 Settings
=1 Free Dox nts
be crosshairs
visible when the | EEi llllllllllllllllllllll
cursor is over the HEEEEEEEEEEEEEEEEE NN
PCB area: T
INEEEEEEENIIEEEEEE NN -
Files ) Projects | Navigator i PCB 4 PCB Fiter ', M Top Layer | M Bottorn Layer | M M1 Board Oulline | B M2 Board Dimensions /M M3 3D STEP Top {8 M43 STEP Bottom /M M5 AssermtEI®N £) 7 Snap Mask Level Clear

Left Click ONCE when the crosshairs are
positioned at the desired location.

ﬁ Jump To Location [mi

#-Location

For accurate placement, press J then L (for Jump VLocation 1000
to Location) and type in the desired coordinates

then press OK and then Left Click once:
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Entering Coil Parameters: '“dug%l!éhée

Enter the values into the window. The trace Space is S, Trace Width is
W, and Center Space Dia is d;,. You can check the box next to Metric
for units of mm instead of mil.

Enter the Number of Turns in “Turns”.

Place_sprZ_form Elﬂu
Q - IL' — . I B 2 N
Trace Space 5 mil [ Metric
Trace Width 3 mil
[ Generate Center Via
Center Space Dia 40 mil
Via Size Dia 20 il [Tl Counter Clockwise Spiral
Via Drill ia 10 =
Turns 5
cancel
¥ Position 1512
Y Position 2534
Layer Top Layer -
|
]
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Center Via: '”duecn'!ﬁhée

A Center Via can be placed also if desired by clicking Generate Center
Via. This is optional and can be done later.

A Center Viais needed with inductors that have coils on multiple
layers. Enter the Via Size Dia (Diameter) and Via Drill Dia (Diameter).

=

& Place_spr2_form = |2 |
Trace Space 5 mil [] Metric
Trace Width 3 mil
[ Generate Center Via
Center Space Dia 40 mil
Via Size Dig 20 mil [] Counter Clodawise Spiral
Via Drill ia 10 =
Turns 5
¥ Position 1512
Y Position 2534
Layer Top Layer -
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Coll Placed |nduecn! hée

Success!

v B v e e woooe.PcbDocViewMName=PCBEdi ~ () -

!'j DKP Eile Edit Wiew Project Place Design Tools AutoRoute Reports Window Help B - =
A W | o S E | (Mot Saved) - ; 1

= =8

[Meo Yariations] -

JEH S A ® @ Q@
. -
S #X | 3 Blankshest_ANSLB SchDoc (5]] spiral2-cobervbs | | [ BlankShest_ANSKB SchDoc| | BE xooceo PobDoc *

FLA Pmiec“ P[IPEB Pmled __l

@ File View Structure Editar k- AR 1
=] PCB_Project] PrPCB =
= Source Documents
[ Cover Sheet_&NSI-B.SchDac *
[ BlankShest_AMSI-E.5chDoc
[ Hardware_aH51-B. Schloc *
L Settings
Bl Free Documents
B Source Documents
| (57l spiral2-cober.vhs
| 4 BlankSheet_&NSI-B.SchDoc .I
.Eﬂ ronline_rect_spiral. vbs

}

SPT Snap Mask Level | Clear

Whorkspacel.Dariwrk * ||"Workspace

di

4

', M Top Layer £ M1 Board Outine 4 M 12 Board Dimensions M #3 30 STEP Top M 14 30 STEP Battom | M

Files ) Projects . Mavigator ( PCB i PCE Filter
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Finishing Steps...
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Multi-Layer Colls Induecr;'!'g%e

When making multi-layer coils, be sure to alternate the clockwise and
counter-clockwise rotations. Use the same parameters for the
alternating coil — and be sure to click on “Counterclock wise”

SRR SRR RN AT - o WL LLLLLLELELRE

Trace Space ° mil Metric

Trace Width 5 mil
Generate Center Via
Center Space Dia 40 mil

Counter Clockwise Spiral

Via Size Dia 20
Via Drill Dia 10

Turns 5

| cancel |
¥ Position  2584.5

' Position 3494

| ok

Layer Bottom Layer -
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Multi-Layer Colls Sensk

Here you can see the bottom layer coil is wound counter-clockwise,
while the top layer coil is wound clockwise.

!'j DxP File Edit View Project Place Design Tools AutoRoute Reports  Window Help B -~ = v B x| v 3 xoocc PcbDoc?ViewName=PCEBEdi -
DEH S0 | ®E @5 aqr I TR 7 | | (Not Saved) - 1 :[NeVariations] =

N ¥ #X || 3 Blanksheet_ANSLB SchDoc| | (5] spiral2-cobervbs| | (3 BlankSheet ANSLB Schoc| | B xoo000c PobDoc *

e v |kaspaCE| __l

| T

PCB_Projectl.FriFCE Fraoject
@ File Yigw Structure Editor EI 1515
=il PCE_Project].PriPCB = 3
= Source Documnents
2 Cover Shest_AMSI-B.5chloc * 5
2 BlarkSheet_AMSI-B.Schloc
[ Hardware_&NSI-B. SchDoc * )
1 Settings
E Free Documents
= Source Documnents
(57 spiral2-cober vbs
4 BlarkShest_&MS5I-B.5chDoc
.g] nonline_rect_spiral vbs

b

«
\l Top Layerhl Bottom Layer ‘f{lD b1 Board Elutlinef{ll 142 Board Dimensions‘f{ll 3 30 STEP Top‘f{ll b4 30 [E[H Sp7F Snap Mask Level | Clear

Files » Projects . MNavigator 4 PCB 4 PCB Filter
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Induc'l'g]\/e

4 Layer Inductor Design Senskng
(( ))) Clockwise Out
°__K Spiral on Layer 1
<To LDC Sensor

Capacitor Via from Layer 1 to Layer 2

Counter-Clockwise Qut
Spiral on Layer 2

Via from Layer 4 to Layer 1 Via from Layer 2 to Layer 3

Clockwise QOut
Spiral on Layer 3

Via from Layer 3 to Layer 4

Counter-Clockwise Qut
Spiral on Layer 4
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Setting the Net for the Coll

INclcl:

Sensk

To connect the coil to the rest of the circuit, you will need to set the net

for the coll.

It is useful to only work on the
signal layers for the following
step.

To do this, left click on the LS

and select Signal layers.

Projects
\workspasel Dsniwik
PLCB_Fioject] PiFCE

@ File View Structure Editor

Press and hold the left
mouse button to draw a
box around the coils.

sl PCB_Project].PrPCB *
D
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Multi-Layer Coils '”dugl!%hée

Left click on the PCB box and choose “PCB Inspector”

‘ ‘ « [ 3
‘ » ' Files ) Projects [ Mavigator . PCE { PC \ll Top Layerhl Bottom Layer AI:I Multi-La_l,ler]‘ PV il Loyl Clea™\

1190w "-900mi  Grid 10mil [Hotspot Snap (41l Layers]] System | Design Compler | Help | [nst® -'w
Idle state - ready for command

PCB Inspector
[nzlude anly Arcs ’
Then Change the Net to the HKind
. Object Kind A
desired Net from the Bl Object Specific
schematic T E— i -
o Mo Met
Solder Mask Expansion %
Solder Mazk Expanzion Mode Mone
FPazte Mazk Expanszion Ol
FPaste kazk Expanzion Mode MHone
El Graphical
x1 ..
1 1000l
Width Sl
Locked
Radiuz .y
Start Angle Lo,
Stop Angle Lo,
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Completing the coll |ﬂdueCn'!§Me

Move the sensor capacitor close and connect the capacitor to the coil.

Projects v K

Workspacel.Dern Tk * | [Workspace

PCB_Project1.PriPCB
@) File Wiew Structure E ditor

[d BlankSheet_ANSHE SchDoc| | [5j] spiral2-cobervbs| | [ BlankShest ANSLE SchDoc| | B8 soooox PebDoc *

=l 21| PCB_Project1_PriPCB =
= Source Docunments
[ Cover Sheet_AMNSI-B.5chDoc
[ BlankSheet_&NS5I-B.SchDoc
LE Hardware._ .-’-‘«NSI B SchDoc
. B

[ o PobDioc
Hid Settlngs
=1 Free Documents
= Source Docunments
(5 spiral2-cober vbs
[ BlankShest_&MSI-B.SchDoc
Igﬂ nonline_rect_spiral. vbs

PCB_COIL
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Ind%c'l'g.}\/e

ensking

Completing the coll

Also, we had to place a via to get from the bottom of the board to the
top for the capacitor.

Fro) o .4 BlankSheet_ANSIB.SchDoc .El] spiral2-cober.vbs| | L2 BlankSheet ANSHB SchDoc| | B8 xcocooc PebDoc *
Workzpacel. Diarwik * ||Workzpace
PCE_Prajectl PiPCB

@ File View Structure Editor

=gl PCB_Projectl.PriPCB *
=L Source Documents
2 Cover Sheet_&NSI-B.5chDoc
2 BlankSheet_&NSI-B.SchDoc
2 Hardware_AMSI-E.SchDoc *
Ex Pebboc *

[ Setting
=L Free Documents
= Source Documents
51 spiral2-cober. vbs
2 BlankSheet_&NSI-B.SchDoc
51 norline_rect_spiral.vbs

PCB_COIL
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Tented Vias

It is recommended to put
tenting (covering the Via with
soldermask) on the vias.

1. Select the Via, and choose
properties.

2. Then click on the tenting
options for both top and
bottom.
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ensking

@ Simple ) Top-Middle-Bottam (71 Full Stack
Hole Size  10mil Diameter  20mil
Location X: 1392.5mil
¥: 1960mil
Properties Solder Mask Expansions
Start Layer Top Layer @ Expansion value from rules
End Layer Bottom Layer ‘ ) Specify expansion value
N
Met Mo Met
[ F-:uru:e complete tenting on top
Locked D Force complete tenting on bottom
Testpoint Settings
Top Bottom
Fabrication [ =
Assembly [ =

[ QK ] [ Cancel
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